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N Creo Parametric 4.0 M010

¢ Run ModelCHECK for Creo Elements/Direct Modeling *.sdac and *.sdpc file using Open option
o CS248781

« Publish Augmented Reality (AR) experience directly from Creo
o CS257684

« New solution Clearance and Creepage Extension (CCX) added into Creo Parametric 4.0 M010
o CS260097

Creo Parametric 4.0 M020
« STEP AP242 supports Semantic PMI (Product Manufacturing Information) on Import and Export
o In previous releases and datecodes, only Graphical PMI has been supported, refer to CS193762
« Smart connected product design will be launched as Creo Product Insight Extension
o The license option for Creo Product Insight Extension is PRODUCT_INSIGHT (359)
= Product insight extension (Creo > Thingworx connection) with sensor features
= Add Sensor by File > Prepare > Model Properties
= Create an Instrumented assembly
o Refer Creo Product Insight Extensmn Introductlon video from http://learningexchange.ptc.com

Creo Parametric 4.0 M030

« Creo Render Studio
o From Creo 4.0 M030, Creo Photo-Realistic Rendering is renamed to Creo Render Studio, also provide the related standalone App - Creo Render Studio
o Requires CREOSHELL Basic license to install and then Render Studio (feature 357) to run

e Creo 4.0 MO30 import/open support NX 11.0 and Solidworks 2017
o CS5134024

« Creo Product Insight Extension
o Advanced sensor support
o Virtual sensors
o Mechanism analyses
o Creo as a Service




ITY (MO10
oY

ools iew ramewor ications !
Tool \ F k Applicat o
[] -‘r@; .{ﬁ(/_-'[ _Q_J Connect to Server ._J UDF Library Q/ Image Editor - [+ % D 4]
i -g). W oy
l_‘ﬂ érQ Load Data ~ ['j Appearances Manager _,j}' Import Profile Editor
Insert Sensor Info = Add Screw Dowel
le d= Sensor andSetup e View Data 1, Auxiliary Applications ThingMark U ¥  Pinv
Sensor ¥ Utilities Augmented Reality Intelligent Fastener ¥

q @& e Q0,058 %wE



J Creepage Extension (CCX
g

Creepage and
Clearance Analysis

Net Name Net Type

Net1 T eotential =
VNetZ | potential

Net3 | Grounded
| Neta Potential-free
| Net5 Potential-free
“Netﬁ | potential-free ] hd|

| Merge Nets | Reset Nets |

Auto merge distance |0.00

+{ mm | Auto Merge N
Source: | Netl 5
Target Net Clearance Dist. Creepage Dist. Groove Wid
| Net2 |7.00 f
| Net3 7.00

[l
Clearance Creepage

Compute Current Source | Compute All

Analysis Summary

Target Net Cl.  Cr. || Clearance Creepage
| Net2
|Net3
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* Add phys
New Instrume
* Protecting reuse

Associated paramete
* Define parameters a ensor
®Uiiput.Clearancelmm]

Read real-world data f R
data file) and use input v
analyses

* Run analyses and report res




Creo Parametric 4.0 M030
« Creo Render Studio

o From Creo 4.0 M0O30, Creo Photo-Realistic Rendering is renamed to Creo Render Studio, also provide the related standalone App - Creo Render Studio

o Requires CREOSHELL_Basic license to install and then Render Studio (feature 357) to run

~] » C:» Program Files » PTC » v

Choose from the list below: Customize ...

Application Version Install Size  Diagnostic Reporting  Status
v (4 Creo -
Creo Common Files 4.0MO030 29GCGB Required
Creo Direct 4.0 M030 299 MB No Licenses found
Creo Distributed Services Manager 4.0M030 100 MB No Licenses found
Creo Layout 4.0M030 24 MB No Licenses found
Creo Options Modeler 4.0MO030 24 MB No Licenses found
W Creo Parametric 4.0 M030 19GB v New
Creo Render Studio 4.0 MO030 108 MB No Licenses found
W Creo Simulate 4.0 M030 692 MB v New
v [ ] PTC Mathcad

[[] PTC Mathcad Prime 4.0 M010 629 MB

New

Total Space Required: 5.7 GB (44 GB Available)







praktisk "ve klyg att kanna till
CREO | SON - o2e Usgengineering | PLM & CAD Consultancy

.A professionals
Welcome to OpenSource Automation for PTC's CREO Parametric!

This is an Open Source Initiative by Simplified Logic, Inc. UT001S

SF SIMPLIFY

MECHANICAL DESIGN AUTOMATION

sPurge
sBatch
sPlotdate
sFlush

Nitro-PROGRAM
Graphical Pro/PROGRAM Editor!

Designed for unparalleled ease-of-use for drag-and-drop program editing within Parts and Assemblies.
THIS is a MUST-HAVE Tool for ANY serious CREO Automations!
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Interface

Interface

JavaScript

Pro/TOOLKIT Pro/TOOLKIT

Objective-C

Visual Basic Visual Basic

PARAMETRIC PARAMETRIC

e APPLICATION

ObjectToolkit - i

ObjectToolkit

C/C++/C#

ObjectToolkit Visual Basic

—
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AL i i
Tl
Tech
Python

PHP
Ruby

Swift
etc... YOUR
APPLICATION

JAVA

etc...
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SF SIMPLIFY

MECHANICAL DESIGN AUTOMATION
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Nitro-PROGRAM

Graphical Pro/PROGRAM Editor!

Designed for unparalleled ease-of-use for drag-and-drop program editing within Parts and Assemblies.
THIS is a MUST-HAVE Tool for ANY serious CREO Automations!

ohe USgengineering |
A professionals Search (Click to apen) s

+ [ cylindes
[A] #EADER

: . - ] mweuT
epe USgengineering PLM & CAD Consultancy [® rezatzons
professionals | S B at Ch Mapkey /f? RIGHT
Select mapkey to execute on Mapkeys to execute in j_): ;—;:,,-,
. the selected files. Pro/Engineer, “ %« PRT_CSYS_DEF
uTools % s
i e p || LI I - IF HOLE STATE == "CEN" | HOLE STATE == “ALL"
ri - . &) HOLE
i -7 =
SPUI‘ge & about Options s [f] IF HOLE STATE == ®BOLT" | HOLE_STATE == “ALL'
SBatCh ’ ’ . () PH_BOLT_HOLE
SaveFiles " Yes @ No FEraseFiles (" Yes (% No e
sPlotdate | g website EXtPrOE @ Yes CNo  ImportfBport " ves G 1 o
[E] ymzseror
sFlush m exit Sl N
Select to save a config file or to run this batch.
u by PLM & CAD Co VWW.usgengin

(" Save (% Run

B e s, &
Brought to you by PLM & CAD Consultancy http:/www.usgengineering.nl version 5.0
‘ . M N Nitro.Program - Log View

*** Graphical Tree Done! ™ 06/15/2014
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Create co

Favorites
Emironment
System Colors
Model Display
Entity Display

| Selection
Sketcher
Assembly
Notification Center
Data Exchange
Shestmetal
Update Control
3D Printing

Customize Ribbon
Quick Access Toolbar
Window Settings
Shortcut Menu

Licensing
Configuration Editor

Favorites

Customize: | Ribbon -
Emironment
System Appesrance
Model Display Select a Mode on drgging s fromthe st on the eft or
Entity Display
Selection
Sketcher Showz| All Modes A -
Assembly Category: | All Commands (Standéy) B » Simulate Results: B
Hotification Certes » Simulate Structure FEM 3D
ECAD Assembly Fifter Commands: b Simulste Structure Native 20
ol » Simulste Structure Native 3D —
omlr Hiieuk Shortiut » Simuiate Thermal FEM 30
Update Control <Cascade Menu> » Simulate Thermal Native 20
SoeMn D prommy » Simuate Thermal Native 30
00 » Skeleton Part
&30 Print
v Customize ¥ Sheschor
Ribbon B About Creo Parametric ~ i Space Claim .
Quick Access Toolbar About PT/Products "
Keyboard Shertcuts . -« ¥ [ Home *
B Activate Culea » & D
Window Settings Associstive Topology Bus » ) settings
: » ) Utities
Y Auto Check I
Licensing R9auto Checkin » Style
Configuration Editor Auto Check Status on Activate b Verify Variant Ribbon
Auto Check Status on Retrieve ¥ Micling
» Welding

Auto Check Status on Update
() Common {Globs! Tsb)

Common (Custom)

VT Ausfary Applications
[ Check Out

£0)C lane Histan:

Set the selection options.

| Reset ~|| Export | "t
Preselection highlighting = P L
¥ Enable presslsction highiighting

| My selection filter settings

Choose filter from: My Filter:
Vertex Edge
| Intent Chain | Quilt
Surface Curve
Intent Surface Feature
Intent Datum Curve
Datum Plane
Asis
Coordinate System
Datum Point
Annotation Add=
<<Remove

My Filter

[ Set My Filter as the default selection fiter

My fiter | Import/Export

B T



# Find

Search for, filter, and select items in the

Search Tool:1 x
model by rules.
Look for: Look in:
s — Feature ~| |1_SESM9010208_4 PRT
Look by: [y Include submodels

| Feature =

Attributes | History Status

Rule Criteria
O Name Comparison:
C Type is equal to
B . | ~— () Expression 2
C o CDat:agory.
atum
° Description
Save ) Property Value:
Datum Plane
* Save Qu
. Query Builder
[ ]
Ret re |Ve Q U Rule Description Oper...

{ Type == Datum Plane (Categor... )

* Save Query to
Geometry or Cop

Publish Geometry

References Properties Add New | Remove | Update + ¥
0 Surface Sets
* Geometry Search —in T T | ST :
Details... Excluded
Suppressed

Chain
Click here to add item

Not Retrieved

Not Placed
Details...

» Geometry Search @

O  Filter Tree
References
Query #1

)

Search and select geometry items in the

Highlight ltems
M model by rules.

O Filtered Selections
Details...

n; &  Build Query
1 B Annotations Save Query... .
nE Regions and Surfaces d N Save Query To File...

Retrieve Query File___
O  Save Query To Feature
Sort By...
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¥ 31 Pattern 2 of XSEC0001
(¥ xsECo001 L
[« XSEC0001-2 .
[ XSEC0001-3
() XSEC0001-4 -
= 4 hatch editor

¥ Commands not in the ribbon
Hatch Editor

0,0,10, 0,150,215,-10
s o0,0,75, 0,150,215,-10
4 90,0,10, 0,225,65,-85
s 90,-10,10, 0,225,65,-85
6 0,46.25,85, 0,150, 102.5,-10
7 0,46.25,150, 0,150, 102.5,-10
90,36.25,85, 0,112.5,65,-85
90,46.25,85, 0,112.5,65,-85

* Linear a
found on ne
e Saving hatch pz:
for next use .
. = HBRICK pat 3 |
P CO nflg Defa u It—ha “HBENGLET, Brickwork english bond Free patterns from www.AUTOCADhatch.com
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Model Tree ‘ﬂ b j
=~

(0] SXK1089446_1.ASM
o AYZ

7 AXZ

& AXY

B ACS0

[ SXA1070322_1.PRT
[ SLA10551_1.PRT
(@ SLA10551_1 PRT
() SXA1070323_1PRT
[ SLA10552_1.PRT
[ SXA1070324_1.PRT
% APNTO

7 AA

# Insert Here

¥ ¥y ¥vyvvy¥

opo

+ &

e 2 5 @
Model Tree ‘TJ‘ = j < Em

[J SXK1089446_1_ASM.PRT

» Annotations

7 YZ
L7 X7

From: c:\prouserstu020019workisxk1089446_1_asm.stp

Type

@ O Pan ) 2] Format L0 XY
O & om0 E Laves #x CS0
© =] Notebook 57 Import Feature id 41
% Insert Here
» f Footer



Define Properties by

Geometry and Parame ters x| B

Coordinate System

Default CSYS Use Previous

Alternative Coordinate System

Default CSYS Use Previous [d Dependent

Basic Properties Center of Gravity [mm]
Density: 1.000000e+00 kg/mm*3 || X

Asse
decrea

%

& B Volume: mm*3 Y:

Mass® | 3.200000e+00 kg z

z
3
&

mm+2

Set config cc NnQye, _\ i\\" [/
' ; - v W

R

Component placement controls .

Set config packe

Show ”Placement
Use CNTR+ALT to avc

Allows reorientation of components during placement

* Component Drag 5J
+spi G
u

* Move




‘ |How to change default constraint type

« Set config option auto_constr_always_use_offset - Never

« Coincident will be the default constraint type when reference pairs are planes, linear edges or
datum axes or planes to edge pairing

+ Set config option auto_constr_always_use_offset - Yes

+ Offset (Angle or Normal) will be the default constraint type (never coincident) when reference
pairs are planes, linear edges or datum axes, planes to edge pairing

« Set config option auto_constr_always_use_offset - No

« System will pick up constraint type (coincident / distance / angle / normal) based on position
and orientation of component

\How to change default constraint type

» When auto_constr_always_use_offset is No, the following config options
determines angle or normal constraint type using the angle epsilon
+ Comp_angle_offset_eps (-1)
+ Comp_normal_offset_eps (-91)

+ If the component position does not fit angle or normal, then it will be either
coincident or distance. System decides based on this config option

+ Auto_constr_offset_tolerance (0.5 times model size). If current distance between references is
bigger than this value, then it will set the constraint type to distance. If less, then it will set to
coincident

N

|Constraint Sets in Creo

* Multiple constraint sets for components.
» Enable/Disable for alternate positions.

* New parameter — PTC_CONSTRAINT_SET can be used in Family table or in
model tree column to switch positions.

PTC_CONSTRAINT_SET

7 ne
v () 428-0002-001 ASM 23YD
v ‘T Placement
| » 237D
| » @28YD
| » @32Y0D



* In a Drawing, select the Window overflow from the View tab and pick New.

udl 7

You will be prompted for a sheet number to navigate to.

Tools View
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Enter sheet 1o daplay - you may add 3 new sheet (14
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* You can now work in multiple drawing sheets simultaneously. (Also works

well for large models where regular reorientation is time consuming).
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Include in library

Share with =

Burn

adv_materials

Name

adv_materials
appearances
d3d_shaders
hdri

lights
materials
ogl_shaders
rooms
scenes

textures

appearances
d3d_shaders
lights

| materials '
)

ogl_shaders

Appearance  Perspective  Render Rende:

| Gallery ~ | View Window Regior

Search... o REv

Appearance| Perspective  Render Rende
| 2 Clear Appearance ~ | rooms | Gallery ~ | View Window Regior

J: ~My Appearances scenes | | Search... I bl

| textures | 2 Clear Appearance ~

I ~My Appearances

1l

000
000
000
000
000
000
000
000
000
000

T
L]
=
o
a
&

©

1
=
=)

a
[

| wLibrary std-metals dmt  ~
1 ®

std-metals.dmt ~

000
000
000
000
000

4

v
0006: ©

5
000
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To Print a Model

1. Click File > Print > Print. The Printer Configuration dialog box opens.

2. On the General tab, Click to select a printer or to add a new printer. The selected printer type is saved for the current session only.
3. Specify the general printing options.

Command Action

Destination Select one of the following check boxes to choose the destination of the print:
* To File - saves the prints of the model to the specified file

« To Printer - prints the model using the selected printer

Combination States Select one of the following:
« All - Prints all combination states available in the model.
* Current - Prints the active combination state.

* Range - Prints a range of combination states. When you select Range, the Define
option becomes available. Click Define, and select the combination states that
you want to print from the Define Range dialog box

Format Specify the format (*.frm) to be used as a background for printing. The Format drop
down list lists the previously selected formats. Select a format from the drop down
list or click Browse to select a different format.

Options Specify the number of copies to be printed and set the plotter command to be used
when sending a plot to the printer.
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Simulate

To remove a feature within Creo Simulate:

1. Using Creo FMX, highlight the feature you'll remove.
2. On the Refine Model ribbon bar, click Remove.
3. Preview and/or Accept the change.

It's important to note that currently the change is only applied in Creo Simulate. You
must promote changes made in Creo Simulate to apply them to the parametric model. To
promote a change:

1. In the Model Tree, expand Simulation Features.
2. Right-click the removed feature and select Promote.

The system applies the change to the parametric model.
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ptc: community

Q Searchallcontent

This category  ~

Creo Modeling Questions Announcements

F ok o+ o+ F o+ o+ o+ o+

No mater your years of Creo Modeling experience, PTC Community 112208 112181 T
members can help you be more efiicient and productive: ask a 0sTS NEw - migration, We have closed the
question, supply an answer. Community Issues Board and our
Intemal teams are reviewing any
Additional Creo Questions Outstaiding [PORMS,
From Creo Customization to Visualize this s the place to d i 1982 38230 peurs ago
rom Creo Customization to Visualize this is the place to discuss a - | 2housag R R
things Creo. is available under Community
Helo, Change Your Community
Creo Ideas Usermame Read The Post
PTC is committed to producing superior products, please submit
your ideas here. In order to participate in Product Ideas on PTC 9755 orsa
Community you will need to upgrade your PTC.com account to posTs ew ! Top Kudoed Authors >
include support. Pl PTC Community ith
uesions now o upsrace. @ it o
Creo Blog T .
1908 1907 nlazarine a18
This blog is for offieial Cres announcements and articles from PTC, Tuesday
s New

its employees, and our valued community members.
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What's

il
New Creo 4.0

= Creo Tutorials

= Creo Tutorials

+ Creo Parametric Tutorials
+ Creo Flexible Modeling
+ Creo Intelligent Fastener Tutorials
+ Creo Advanced Framework
Extension
+ Clearance and Creepage Extension
+ Creo Simulate Tutorials
+ Creo Render Studio Tutorials
+ PTC Mathcad Tutorials
Fundamentals
Model-Based Definition
Data Management
Design Exploration
Part Modeling
Data Exchange
Detailed Drawings
Layout
Surfacing
Rendering

PTC Creo eSupport

Creo Tutorials

PTC provides tutorials to help you get started with Creo. You
will need a valid account on PTC University Learning
Exchangeto download models.

® Creo Parametric
= Beginners Tutorials
* Creo Flexible Modeling
= Beginners Tutorials
* Creo Intelligent Fastener

- Beginners Tutorials

* Creo Advanced Framework Extension

= Beginners Tutorials

* Clearance and Creepage Extension

= Beginners Tutorials
e Creo Simulate

= Beginners Tutorials
* PTC Mathcad

+ Beginners Tutorials

Home My Company Creo & Pro/ENGINEER windchill Mathcad Creo View & Productview ¥

Search knowledge articles, best practices, and more ...
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Calculation

S pic

STORE HOME

CUSTOMER SERVICE

Tools View Flexible Modeling = Applications

'RITEMS IN BASKET: 0

PTC Mathcad Worksheets

All Products

Creo Parametric
PTC Mathcad

PTC Mathcad
Worksheets

Creo View
Student Editions.
PTG University

Global Support now
ava h

PTC eLearning!
Learn more >

TELL A FRIEND (2]

Select Currency: SEK v
Viewing[1-8 v |of 8
Roark's Worksheet Library - 6th Edition for PTC Mathcad Prime 4.0

Roark's Roark's Worksheet Library - 6th Edition for PTC Mathcad Prime 4.0 allows engineers to easly
calculate stress and strain management. This worksheet kbrary covers straight beams and bars,
Worksheet Curved beams, plates and shelis, and mare!
Library 4,730.00 SEK
ORDER NOW
o= cition 3]

PTC Mathcad Worksheet Library - Volume 1

PTC
Mathcad

Worksheet
Ubrary -
Voiume 1

PTC Mathcad Worksheet Library - Volume 2

The PTC Mathcad Prime Worksheet Library - Volume 1 consists of hundreds of worksheets o
wide you with the tools you need 1o solve bigger problems, faster. Whether you're just getiing
sStarted with PTC Mathead Prime 3.1, of you are an expert, this library gves you the 100l you nead
10 get your job done faster!

5,780.00 SEK

'ORDER NOW

The PTC Mathcad Worksheet Library - Volume 2 consists of over 700 worksheets across nine
worksheet collections. This worksheet library addresses the topics: mechanical engineering solved
problems, statistics, physics, solving and physics signal
processing, and data analysis.
5,780.00 SEK

P1C
Mathcad

r_vglbluﬂ
ibrary -
Yolame?

PTC Mathcad Worksheet Library - Applied Math

ORDER NOW

PIC The PTC Mathcad Worksheet Library - Applied Math consists of over 400 worksheets.
‘addressing: differential equations, statistics, solving and optimization, and data analysis.
Mathcad 2,150.00 SEK

ORDER NOW

Worksheet
Library -
| Apptediath,

Browse v

Community > PTCMathcad > PTC Mathcad Blog > PTC Mathcad - All Worksheets

Blog v | Q Search all content

PTC Mathcad - All Worksheets

ﬁ TudorMarin Level 1

Want a free copy of PTC Mathcad Express? Download your copy today.
New Users to PTC Mathcad:

» Getting Started
» Natural Math and Units

Explore worksheet categories:

» Algebra & Geometr
o Calculus, Statistics, and Data Analysis
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Overview File Options

This is a session to provide training on CFD
solution fully embedded in creo — powered by
simerics. And to receive feedback



